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1 -   DÉCALER LES  PARAGRAPHES  

Utiliser les curseurs présents sur la règle que l'on peut
combiner avec les outils d'alignement (4)

1. Retrait à gauche

2. retrait de première ligne

3. retrait à droite 

Important  : éviter l'usage du caractère « espace » pour
déplacer des lignes vers la droite

Il suffit de placer le point d'insertion dans la ligne (paragraphe)
concernée et de glisser le curseur à la position désirée.

Exemple 1 :

Les vagues les étés dans cet arbre ajouré
Dans cet arbre accessible aux couleurs et aux hommes

Leur azur leur ciel pur le mélange des eaux
Leur dentelle et la flamme du matin désert

Deux vallées trois sommets s’unissent font la chaîne
L’océan qui me mène a le destin du ciel

Et la vague initiale amenuise un nuage
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2 -   SERTIR LE TEXTE   (LIGNE DE BUTÉE)  

On  établit des limites en traçant des courbes ou des polygones
ouverts dont on  règle les paramètres d'habillage 

1.  Dans la barre d'instruments, ouvrez les Fonctions de dessin.

Par un une pression maintenue sur le pictogramme, décrocher et
glisser la barre 

2. Tracer un polygone ou une courbe fermée avec l'outil spécifique :

 Polygone

 Ligne à main levée

3. Les objets ne seront pas fermés, il ne pourront donc pas être
colorés.

4. Reprendre  l'outil « Sélection »

5. Selectionner une ligne (clic-gauche), appeler le menu contextuel
(clic-droit).

6.Adaptation du texte->Éditer
Choisir l'habillage adapté  : 
( Avant ou Après ) 
et vérifier que contour est coché. 
Pour un figure centrale non
fermée, il faudra activer aussi :
« Seul l'extérieur »

7. En choisissant  contour invisibles  dans la barre d'objets  on
masque la figure.

On pourra améliorer le contact entre le texte est la ligne avec
l'icône d'alignement (justifié).
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3 -   SERTIR LE TEXTE   (ZONE DE RÉSERVE)  

On  crééra des réserves (zones sans texte) par l'adjonction de
figures (polygones ou courbes fermées). En en réglant l'habillage, on
limite l'espace utilisable par le texte . On pourra les rendre
transparentes  afin  de laisser apparaître des détails d'un arrière-
plan. 

1.  Dans la barre d'instruments, ouvrez les Fonctions de

dessin.

Par un une pression maintenue sur le pictogramme, décrocher et
glisser la barre 

2. Tracer un polygone ou une courbe fermée avec l'outil spécifique :

 Polygone

 Ligne à main levée

Les objets seront fermés par un double clic sur leur point de
départ.

3. Reprendre  l'outil « Sélection »

4. Selectionner la figure (clic-
gauche), appeler le menu
contextuel ( clic-droit)

5. Adaptation du texte->Éditer
Choisir l'habillage adapté  : 
( Avant,Après ou Parallèle  )

6. En choisissant  contour et
remplissage invisibles  dans la barre d'objets  on masque la
figure.

On pourra améliorer le contact entre le texte est la ligne avec
l'icone d'alignement (justifié)
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4 -   INSCRIRE  LE TEXTE DANS UNE FORME  

Le texte va être contenu dans une forme, par saisie directe ou
plus commodément par copier-coller.

1.  Dans la barre d'instruments, ouvrez les Fonctions de

dessin.

Par un une pression maintenue sur le pictogramme, décrocher et
glisser la barre 

2. Tracer un polygone ou une courbe fermée avec l'outil spécifique :

 Polygone ou  Ligne à main levée

Les objets seront fermés par un double clic sur leur point de
départ.

3. Reprendre  l'outil « Sélection ».

4. Sélectionner la figure (clic-gauche) et par un double-clic  (ou
« F2 » ou « Espace »), on entre dans le mode d'édition du texte
dans une figure.

5. Saisir ou copier le texte ( CTRL+V) et quitter le mode d'édition
par la touche « Échap »
Il n'est pas souhaitable de coller du texte comportant des sauts de
lignes  ou de paragraphes.

6. S'assurer que la figure est toujours sélectionnée ( poignées vertes
visibles), appeler le menu contextuel ( clic-droit) :

7. Options : « Texte »  :
cocher  « adapter au contour »
puis « OK »
On pourra masquer la figure en
choisissant  contour et
remplissage invisibles  dans la
barre d'objets .

8. On dispose dans la barre d'objet dessin de l'outil rotation
permettant de faire pivoter la forme et le texte intérieur ou de lui
affecter un cisaillement.
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5 -   PLACER LE TEXTE SUR UNE FORME   

Le texte va suivre une forme tracée à la main. Il est possible
d'adapter son comportement sur la ligne. 

1.  Dans la barre d'instruments, ouvrez les Fonctions de

dessin.

Par un une pression maintenue sur le pictogramme, décrocher et
glisser la barre 

2. Tracer  une courbe avec l'outil de ligne :

 Ligne à main levée

3. Reprendre  l'outil « Sélection »

4. Sélectionner la figure (clic-gauche) et par un double-clic (ou
« F2 » ou « Espace »), entrer dans le mode d'édition du texte sur
une ligne.

5. Saisir ou copier le texte ( CTRL+V) et quitter le mode d'édition
par la touche « Échap ».

6. S'assurer que la figure est toujours
sélectionnée ( poignées vertes
visibles), 
appeler l'outil FontWork  : Menu
« Format-> Fontwork »

7. Activer  : 
« Rotation », 
« Taille du texte  adaptée »
« Contour » ( afficher/masquer)

8. On pourra également régler d'autres
paramètres : ombrage des
caractères et alignement du texte...
( voir le détail des fonctions)
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6 -   DÉFORMER LE TEXTE   

1. Activer l'outil texte dans les fonctions de dessin.
(attention n'insérer pas un cadre avec les outils d'insertion)

2. Par étirement définir un cadre et y saisir ou coller le texte
(Ctrl+V).

3. Sélectionner le texte ( Ctrl + A) et choisir une couleur soit par le
pictogramme soit dans le menu « Format ->caractères »

4.  S'assurer que la figure est toujours
sélectionnée ( poignées vertes visibles),

appeler l'outil FontWork  : Menu
« Format-> Fontwork »

5. Choisir une forme prédéfinie ( vague en
creux).

6. Activer : 

7. « Basculement vertical  »

8. « Taille du texte adaptée »

9. Si le texte apparaît à l'envers  cliquer
également le bouton « Direction »

10.Ajouter une ombre  « Basculer » et
régler  l'inclinaison et la taille de
l'ombre (150° et 200%)

11.Choisir la couleur de l'ombre portée.
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7 -   INSÉRER UN FOND DE PAGE  

Cette méthode ne permet pas de contrôler les paramètres de
l'image  en fond de page . Elle aura été traitée auparavant.

Un fond de page en aplat coloré peut être inséré (à l'intérieur
des marges) 

Menu Format->Page  index arrière-plan

Type :Couleur , sélectionner la couleur et OK.

Si on désire placer une image comme fond de page , indiquer
Image dans type et rechercher le fichier dans le disque avec le
bouton Parcourir  .

Régler le mode d'affichage de l'image :

 telle quelle à une position définie, agrandie,ou répétée pour couvrir
l'espace) 
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8 -   AJOUTER UN ARRIÈRE PLAN  

Indépendamment du fond de page  il est possible  d'insérer
une image et de la basculer en arrière-plan . Cette technique permet
de régler les paramètres de l'image directement dans Openoffice.

1. Insérer une image :

Menu Insertion ->Image->A partir  d'un fichier

et parcourir le disque pour choisir le fichier. Il est également
possible d'acquérir l'image directement depuis le scanner.

Redimensionner l'image à la taille voulue ( glisser-étirer les
poignées vertes).

Ancrer l'image à la page :
Menu contextuel (Clic-droit ) ancrage...à la page 

2. Appeler les propriétés de l'image :
Menu contextuel (« Clic-droit « )  -> Image 
ou «Double-clic gauche » sur l'image .

Adaptation du texte : Continu
Options : Arrière-plan

On dispose alors de la barre d'objets graphiques permettant
d'ajuster les paramètres de l'image.

Page 10 sur 36



9 -   CONSTRUIRE DES LETTRINES   

Sur un texte existant, il est possible de réaliser une lettrine « à
l'ancienne » en modifiant la taille de la première (ou des premières
lettres d'un paragraphe.

Menu Format ->Paragraphe 

ou  Menu contextuel (Clic-droit ) paragraphe .

Index -> Lettrines :

Définir :
Premières lettres  ou le premier mot 
Le nombre  de caractères  
La hauteur de la lettrine 
Espacement  avec le  texte  et 
Style de caractères ( accentuation)

Il est possible de saisir manuellement le texte de la lettrine.
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10 -   MODIFIER LES CARACTÈRES   

Le module Dessin (Draw) permet d'aller un peu plus loin dans
la modification des caractères, alliés à l'usage de la « Galerie » on
dispose d'une véritable table de montage pour le calligraphe...

Nous allons voir ici comment extraire une ou plusieurs lettres
( objets de type  texte) et récupèrer leurs contours sous forme
d'objets graphiques éditables.

Ouvrir un nouveau document Dessin 
Menu Fichier ->Nouveau ->Dessin 

Activer l'outil Texte ,

1. Définir un cadre et y  saisir ou copier du texte 

(si la police doit être modifiée , le faire maintenant,
ensuite on ne pourra plus la changer !)

2. Convertir  le texte en contour (vecteur) 
Menu Modifier ->En contour 
L'enveloppe devient plus petite ( la taille du caractère)

3. Agrandir l'objet à la taille requise par étirement.
La lettre n'est plus un objet texte  mais un objet
graphique  éditable.

4. On peut modifier les couleurs de contour et de
remplissage .
Outils de la barre d'objets dessins/images 
ou Menu contextuel (Clic-droit ) 

-lignes
-remplissage...

5. Il est également possible de modifier la forme avec les
outils d'édition de points 

6. Quand le résultat est obtenu on  peut rapatrier l'objet
dans le texte par «copier-coller» ou le glisser dans la
« galerie » (cf fiche)
L'objet importé dans le texte est bien un objet graphique
avec toutes ses propriétés d'habillage.
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11 -   ÉDITER LES MOTS   

Il est aisé de transformer un texte en objet vectoriel afin d'en
modifier les paramètres. Cela permet ainsi de manipuler les
contours, le remplissage, l'orientation et l'inclinaison ..

1. Ouvrir un nouveau document Dessin 
Menu Fichier ->Nouveau ->Dessin 

2. Activer l'outil Texte, définir un cadre et y  saisir ou copier du
texte. Si la police doit être modifiée , le faire maintenant,
ensuite on ne pourra plus la changer !)

3. Convertir  le texte en contour (vecteur) 
Menu Modifier ->En contour 
L'enveloppe devient plus petite ( la taille du caractère)

4. Si besoin, agrandir l'objet par étirement.

5. Le dupliquer par « contrôle+glisser »
- cliquer dessus, maintenir le bouton de la souris, le cadre clignote
un instant en pointillés ; sans relacher le bouton de la souris,
enfoncer et maintenir la touche «Ctrl »  et déplacer l'objet.
Il sera copié au relachement de la souris. Répéter l'opération et
répartir grossièrement les objets 

6. Aligner et Répartir régulièrement les objet : 
sélectionner tous les objets( par encadrement) 

Menu contextuel (Clic-droit )->Alignement : 
Menu contextuel (Clic-droit )->Répartition : Verticale
->Écart
Les objets sont maintenant aligné et répartis entre les deux
extrêmes.

7. Vérifier que l'ensemble est toujours sélectionné. 
Menu contextuel (Clic-droit )->Combiner
Cette opération constitue une forme à partir des objets. Les
modifications des paramètres agiront comme si c'était un seul objet .
En particulier le dégradé de remplissage se fera sur l'ensemble de la
forme (et non objet par objet comme dans le cas d'un groupement).
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Éditer les mots (suite)

8. Menu contextuel (Clic-droit )-> Remplissage : Dégradés 
Renseigner les paramètres comme suit  : 
type : Linéaire , angle = 45°, marges = 10% ,
 1ère = Bleu , 2ième = Blanc
Cliquer sur « Ajouter », confirmer le nom et valider deux fois (OK).

9. Choisir un style de ligne invisible pour le contour des lettres.

10.Tracer un quadrilatère sur le « Texte » et le faire passer dessous 
Menu contextuel (Clic-droit )-> Disposition : vers l'arrière

11.Centrer les deux objets l'un par rapportà l'autre : 
Sélectionner l'ensemble ( par encadrement ou sélection multiple)
Menu contextuel (Clic-droit )-> Alignement : Centrage Vertical
Menu contextuel (Clic-droit )-> Alignement : Centrage horizontal

12. On pourra affecter un fond dégradé au rectangle : Désactiver  la
sélection de l'ensemble (Échap ) et cliquer sur le bord du   rectangle.
Menu contextuel (Clic-droit )->Remplissage -> Dégradés
construire un dégradé comme précédemment mais en permutant les
couleurs ( du blanc au bleu)

13.Enregistrer le travail : 
Sélectionner l'ensemble et l'exporter sous un format vecteur (svg).;
l'option « sélection » n'autorise la sauvegarde que des seuls objets
sélectionnés . On peut aussi l'exporter dans un format d'image (png,
gif, jpg) ou le «copier-coller»  pour le placer dans un texte. Il est
également possible de le convertir en bitmap.
Menu contextuel (Clic-droit )->Convertir  : En bitmap 
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12 -   TRACER DES LETTRINES PLUS ÉLABORÉES  

En utilisant la conversion en contour des objets de type  texte,
on pourra créer des lettrines personnalisées.

1. Ouvrir un nouveau document Dessin 
Menu Fichier ->Nouveau ->Dessin 

2. Activer l'outil Texte, définir un cadre et y  saisir ou copier du
texte (si la police doit être modifiée , le faire maintenant,
ensuite on ne pourra plus la changer !)

3. Convertir  le texte en contour (vecteur) 
Menu Modifier ->En contour 
L'enveloppe devient plus petite ( la taille du caractère)
Agrandir l'objet à la taille requise par étirement.
La lettre n'est plus un objet texte  mais un objet graphique
éditable.

4. On peut modifier les couleurs de contour et de remplissage .
Menu contextuel (Clic-droit )-> Remplissage : Dégradés 
Renseigner les paramètres comme suit  : 
type : Linéaire , angle = 0°, marges = 10% ,
 1ère = Turquoise , 2ième = Blanc
Cliquer sur « Ajouter », confirmer le nom et valider deux fois (OK).

5. Il est également possible de modifier la forme avec les outils
d'édition de points 

6.  Par «copier-coller» on peut l'insérer dans une page texte.

7. Positionner l'objet et le passer en arrière-plan :
Menu contextuel (Clic-droit )-> adaptation du texte
->Arrière-plan

8. Activer les fonctions de dessin et avec l'outil rectangle, tracer
un quadrilatère sur la lettre, il servira d'enveloppe. 
Lui affecter une couleur de remplissage invisible et régler
l'habillage
Menu contextuel (Clic-droit )->Adaptation du texte...
->renvoi dynamique

9. On enlevera le contour ( style de ligne invisible) au dernier
moment afin de faciliter le repérage du rectangle.
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13 -   OMBRER LE TEXTE   
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14 -   ADAPTER DU TEXTE À UNE FORME   
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15 -   CONSTRUIRE DES CARACTÈRES AVEC UN  FOND  
TRANSPARENT OU DÉGRADÉ(1)

Nous allons créer des caractères transparents qui pourront
êtres placés sur une image.

1. Ouvrir un nouveau document Dessin 
Menu Fichier ->Nouveau ->Dessin 

2. Activer l'outil Texte ,Définir deux cadres et y  saisir ou copier
du texte . Choisir la police (plus tard, ce ne sera plus
possible). 

3. Convertir  le texte en contour (vecteur) 
Menu Modifier ->En contour
L'enveloppe devient plus petite ( la taille du caractère)

4. Agrandir l'objet à la taille requise par étirement.
Le mot n'est plus un objet texte  mais un objet graphique
dont les propriétés sont éditables.On va pouvoir modifier les
couleurs de contour et de remplissage .

5. Effacer l'intérieur des lettres en indiquant invisible pour le
style  de remplissage et style de ligne continu pour
matérialiser les contours.

6. Nous allons donner à l'autre mot un fon transparent dégradé
qui le fera se fondre dans l'image.
Menu contextuel (Clic-droit )-> Remplissage : 

7. Choisir la couleur de remplissage sous l'onglet :
« Remplissage » 

8. Sous l'onglet « Transparence, renseigner les options : 
Mode de transparence : dégradé

Type : axial
Bordure : 10 %  et garder les autres valeurs.

9. Glisser les « textes » sur une image dans le module de
dessin. S'ils semblent être « dessous » l'image : 
Menu contextuel (Clic-droit )-> Disposition : tout à
l'avant.
Il est possible d'enregistrer l'ensemble (après sélection)
comme une image : Menu fichier->exporter....et choisir un
format d'image adapté (png, jpeg,gif...)

Ou bien transfèrer vers le traitement de texte par copier-coller
( ou en utilisant la galerie).
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16 -   CONSTRUIRE DES CARACTÈRES AVEC UN  FOND  
PERSONNALISÉ (2)

Il est assez simple d'utiliser  un motif ou une image  plutôt
qu'un aplat  comme remplissage de caractère.

1. Ouvrir un nouveau document Dessin 
Menu Fichier ->Nouveau ->Dessin 

2. Activer l'outil Texte ,Définir un cadre et y  saisir ou copier du
texte . Choisir la police (plus tard, ce ne sera plus possible).
Désélectionner le texte ( « Échapp » .

3. Insére l'image qui doit servir de fond au texte :
Menu Insertion->Image...à partir d'un fichier ( ou
scanner) et rechercher l'image avec l'explorateur . En cochant
« Aperçu » on activera la prévisualisation.

4. Placer le « texte » sur l'image et le remettre en premier plan
Menu contextuel (Clic-droit )->Disposition : Tout à
l'avant.

5. Sélectionner les deux objets par encadrement ou sélection
multiple ( maintenir la touche Maj enfoncée tout en cliquant
successivement sur les objets puis relacher Maj).

6. Nous allons réaliser une opération logique entre les deux
images (sur la sélection multiple). 
Menu contextuel (Clic-droit )-> Formes : Intersecter.
A cet instant l'image n'existe plus que comme remplissage des
« caractères ». Ceux-ci sont devenus des objets graphiques
dont les propriétés sont modifiables. 

7. On peut éventuellement masquer le contour des lettres en
choisissant invisible pour le style de ligne.

On pourra remarquer que la taille de l'image a été adaptée
(réduite) à la taille du texte.Cela ne donne pas toujours  l'effet
escompté, si on avait choisi comme fond une zone précise de
l'image. Il est possible d'y remédier : Menu contextuel (Clic-
droit )-> Remplissage ...
 Désactiver l'option « Adapter ». L'image de fond reprendra sa
taille initiale.
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17 -   CONSTRUIRE DES CARACTÈRES AVEC UN  FOND  
DE TEXTE (3)

Pour placer du texte comme remplissage nous allons utiliser les
possibilités de conversion du module de Dessin (Draw).

1. Ouvrir un nouveau document Dessin 
Menu Fichier ->Nouveau ->Dessin 

2. Activer l'outil Texte ,Définir un cadre et y  saisir ou copier le
texte qui servira de fond. Choisir la police, couleur de police et
couleur de fond du cadre  (plus tard, ce ne sera plus possible). 

3. Convertir ce texte en image ( Bitmap)
Menu Modifier->Convertir : En bitmap.
Le texte devient alors un objet de type image au prix d'une
légère dégradation. On peut prévenir ce problème en partant
d'un texte de grande taille dans un cadre important que l'on
pourra réduire après la conversion.

Désélectionner l'image (Échapp.).

4. Activer l'outil « Adapter le
texte au cadre » 

5. Saisir les caractères qui
devront être décorés.

6. Sortir du mode de saisie
( Échapp.), reprendre l'outil
de sélection si nécessaire et

faire glisser le texte sur l'image.

7. Par sélection multiple ( ou CTRL +A), sélectionner les 2 objets.

8. Menu contextuel (Clic-droit )-> Formes : Intersecter

9. Régler  éventuellement la taille et la couleur de contour  des
caractères. 

10.Menu contextuel (Clic-droit )-> Remplissage :
Désactiver « Taille : Adapter »pour retrouver la taille
initiale du  fond.

11.Glisser l'objet dans la galerie ou le «copier-coller».dans le

module traitement de texte.
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18 -   CONVERTIR  DU TEXTE  EN «     3D     »  

Tout objet peut être converti en « 3D ». Cela permet de
contrôler  la rotation  et le cisaillement selon plusieurs axes,
permettant ainsi de nombeux effets « 3D ».

1. Ouvrir un nouveau document Dessin 
Menu Fichier ->Nouveau ->Dessin 

2. Activer l'outil Texte, définir un cadre et y  saisir ou copier du
texte. Si la police doit être modifiée , le faire maintenant,
ensuite on ne pourra plus la changer !)

3. Convertir  le texte en contour (vecteur) 
Menu Modifier ->En contour
L'enveloppe devient plus petite ( la taille des  caractères). 
Agrandir  le texte à la taille voulue par étirement 

4. Convertir le contour en 3D :
Menu contextuel (Clic-droit )->Convertir : En 3D .

5. Fabriquer du rose bonbon :
Menu contextuel (Clic-droit )-> Remplissage : Couleurs :
renommer la couleur  « rose 01 »
->Éditer : choisir un rose dans la fenêtre de gauche et  « OK 
et cliquer sur « Ajouter »

6.  activer le mode de rotation, cela tranforme les poignées qui
deviennent rouges et permettent de faire pivoter la figure.
L'axe de rotation dépend de la poignée utilisée.
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19 -   CONTOURER UNE IMAGE (1)  

Sans faire appel à un logiciel spécialisé, il est possible de
tracer un croquis directement sur l'image, puis d'effacer celle-ci afin
de ne garder que le croquis. Cette technique s'applique bien au
croquis scientifique et à la fabrication de cartes sur des fonds
scannés.

1. Ouvrir un nouveau document Texte 
(ou dessin s'il faut disposer des fonctions de connexion de lignes)

2. Charger l'image 
Menu Insertion -> Image  et parcourir le disque pour accéder
au fichier requis.

3.  Dans la barre d'instruments, ouvrez les Fonctions de dessin.

Par un une pression maintenue sur le pictogramme, décrocher et
glisser la barre 

4. s'assurer que l'image n'est pas sélectionnée 
(Touche Échapp sinon)

5. Choisir un outil de tracé de polygone ou de lignes à main levée

6. On trace directement sur l'image les contours. Cela peut se faire
en une seule fois ou par petits morceaux que l'on pourra
éventuellement relier si nécessaires.
Quand tous les tracés nécessaires sont réalisés , reprendre l'outil
de sélection et clique sur l'image puis l'enlever ( Touche Suppr).

7. On peut à ce moment se contenter de grouper les objets
constituant la figure, cela permettra de les manipuler plus
facilement. Par contre, il s'agit d'un groupe d'objets non fermé
(une succession de lignes plus ou moins contigües) qui ne pourra
pas être rempli de couleur ou de texte. Après sélection multiple,
Menu contextuel (Clic-droit ) Groupe ->Grouper 

8. S'il on à besoin d'un objet fermé, il est nécessaire de le copier
dans le module de dessin (si on l'avait créé dans le module texte)
afin de disposer des outils de connexion de lignes.

(Pour connecter les lignes voir fiche 15)
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20 -   CONTOURER UNE IMAGE (2)  

Connexion des lignes

1. Copier le tracé dans le module de dessin (si on l'avait créé
dans le module texte) afin de disposer des outils de
connexion de lignes.

2. Activer l'Édition de points .

3. A cet instant  si on clique sur les contour on remarque qu'il
est constitué d'une succession de portions, mais que l'on ne
peut pas,tout sélectionner en une fois .

4. Sélectionner deux portions contigûes :
(Maintenir la Touche Majuscule et cliquer successivement
sur les parties du contour choisies.

5. Appeler le Menu contextuel (Clic-droit ) 
-> Connecter

6. Répéter l'opération pour les autres parties. Si la connexion
se réalise mal ( lignes en travers) c'est que les extrémités
des lignes ne sont pas suffisamment proches ou orientées
dans directions différentes. Il faudra agrandir l'affichage
pour visualiser nettement les points et mettre les points des
extrémités en superposition avant de réaliser la connexion.
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21 -   DÉTOURER UNE IMAGE (FOND BLEU)  

Lorsqu'on maîtrise la prise vue , il est pratique d'enregistrer les
objets sur un fond bleu (ou une autre couleur improbable dans le
document). En effet, il est aisé d'affecter une valeur de transparence
à une couleur de l'image .

1. Charger l'image dans le module de dessin.

2. S'assurer qu'elle est bien sélectionnée ( poignées vertes
apparentes)

3. Appeler l'outil « Pipette »
Menu Outils- >Pipette

4. Cocher le premier  rang de
couleur  et s'assurer que la
dernière colonne indique
« Transparent » 

5. Si besoin : augmenter le
seuil de tolérance afin
d'accepter des variations de
la couleur choisies ( zones
d'ombre par ex.)

6. Cliquer sur le pictogramme Pipette puis pointer sur l'image une
zone d'aplat bleu ( le curseur a pris la forme d'une main)
la couleur s'inscrit dans la case correspondante 

7. Appuyer sur «Remplacer ». la couleur sélectionnée est
remplacée par une valeur de transparence. 

8. Répéter l'opération jusquà ce que tout le bleu soit effacé.

9. On pourra enregistrer l'image dans un format adapté ( Png ou
Gif)

Menu fichier->Exporter->... et choisir le type de fichier.
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22 -   DÉTOURER UNE IMAGE PAR MASQUAGE   

Lorsqu'on ne dispose pas d'une image sur fond bleu on pourra
détourer une image en appliquant sur celle-ci des courbes fermées.
L'intervention d'opérations logiques sur les formes permettra
d'extraire la zone désirée. 

1. Charger l'image dans le module de dessin et la dupliquer.

2. Ouvrir le menu «courbes» et activer l'outil « ligne à main levée »

3. Contourer sur la deuxième image la zone à garder.
Éventuellement, on pourra affiner les contours en passant en
mode d'édition de points.

4. Sélectionner les deux objets (l'image et le tracé) et construire un
masque : 
Menu contextuel (Clic-droit )-> Formes->Soustraire
On obtient alors le contour de la partie non désirée.

Pour plus de lisibilité, on pourra lui attribuer un remplissage en aplat.
Régler le contour sur invisible et couleur blanche (!) cela évitera des
petits soucis par la suite.

5. Superposer le masque obtenu à l'image initiale.

L'opération sera facilitée si on a enclenché la capture aux
points de l'objet dans la barre d'options ( dont il faudra peut-
être activer l'affichage).

6. Sélectionner et Combiner les deux objets
Menu contextuel (Clic-droit )-> Combiner 

7. On pourra ensuite exporter le groupe sous un format
d'image adapté (png, jpg,gif...) 
ou l'insérer par «copier-coller» après l'avoir  converti en
bitmap :
Menu contextuel (Clic-droit )->Convertir->En Bitmap
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23 -   MODIFIER L'ENVELOPPE D'UNE IMAGE (1)  
( AUTOMATIQUE)

Quand on place un objet ( graphique ou image)dans une zone
de texte, les fonctions d'habillage permettent de régler la façon dont
le texte se comporte autour de l'image . Il est d'ailleurs possible
d'ajuster le retrait tout autour.

Menu contextuel (Clic-droit )-> Adaptation du texte 

Dans le cas d'un objet graphique l'habillage peut  se faire aux
contours de l'objet : (voir fiche 4 ). 
Avec une image, OOo  considère que l'enveloppe de l'objet ( la
zone d'où le texte est écarté) est rectangulaire. Il est néanmoins
possible de l'ajuster à un élément de l'image. 
Ici encore le « fond bleu » va  faciliter le travail

 Menu contextuel (Clic-droit )-> adaptation du texte :
Éditer le contour :

1. Ajuster la tolérance ( 35%)

2. Activer la pipette , cliquer
sur une zone d'aplat et
confirmer la création du
contour.

3. Activer l'icône « Éditer des
points » afin de corriger les
petites excroissances
éventuelles. 

4. Sélectionner un  point et
l'effacer
( « Suppr » ou
icône« Supprimer des
points ») 

5. Assigner le contour à
l'image

6. Le texte habille l'image au
contour ainsi créé.
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24 -   MODIFIER L'ENVELOPPE D'UNE IMAGE (2)  
( MANUEL)

Quand le fond de l'image ne présente pas une couleur uniforme
ou est dans une teinte trop proche de l'élément que l'on veut garder,
le fonctionnement automatique ne restitue pas des  résultats
satisfaisants.

Dans ce cas il est possible de définir manuellement l'enveloppe
de l'image. On dispose d'outils de tracé élementaires dans l'éditeur
de contour. Le temps nécessaire sera fonction de la complexité  de
l'objet à isoler (et de l'habileté de l'utilisateur  ! ). 

1. Insérer l'image dans une page de texte: 

Menu Insertion -> Image-> A partir d'un fichier...

2. Sélectionner l'image si elle ne l'est pas.

3. Menu contextuel (Clic-droit )-> adaptation du texte : Éditer
le contour :

4.  Utiliser l'outil polygone et tracer ( grossièrement) le contour

5. Il est possible de passer  en «Édition de points » afin de corriger
le tracer.

6. Assigner  la forme à l'image  et fermer la fenêtre.

7. Le texte habille l'image au contour ainsi créé.
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25 -   ÉVIDER UNE IMAGE  

Nous allons « percer » une image  avec un  contour ou des
caractères, de façon à voir à travers comme par le trou d'une
serrure.

1. Ouvrir un nouveau document Dessin 
Menu Fichier ->Nouveau ->Dessin 

2. Insérer une image 
Menu Insertion->Image : à partir d'un fichier 
utiliser l'explorateur pour accéder à l'image désirée. L'insérer
et la redimensionner si nécessaire.

3. Désactiver la sélection de cette image (Échapp.) et choisir
l'outil de dessin « Ligne à main levée remplie » 

4. Tracer sur l'image, le contour de la forme qui sera évidée.

5. Sélectionner les deux objets ( sélection multiple ou CTRL+A)
puis :
Menu contextuel (Clic-droit )-> F ormes : sosutraire.
La forme vient d'être enlevée de l'image.

6. On peut alors placer un texte dans un cadre, puis le disposer
sur le trou et le faire passer derrière :
Menu contextuel (Clic-droit )-> Disposition : Vers l'arrière.
(On aurait pu utiliser une seconde image).

7. Grouper les objets pour les manipuler avec plus de commodité.

8. Glisser le groupe  dans la galerie ou le «copier-coller».dans le
module traitement de texte.
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26 -   VECTORISER UNE IMAGE ( BITMAP)  

Open Office dispose d'un outil permettant de transformer une
image  en contour ( ou polygones). Il est assez pratique pour
convertir des illustrations (cliparts) en objets vectoriels ne
présentant plus de « pixellisation » à l'agrandissement.

On obtiendra également quelques effets graphiques
intéressants.

1. Ouvrir un nouveau document Dessin 
Menu Fichier ->Nouveau ->Dessin 

2. Insérer une image 
Menu Insertion->Image : à partir d'un fichier
utilisier l'explorateur pour accéder à l'image désirée. L'insérer
et la redimensionner si nécéssaire.

3. Menu contextuel (Clic-droit )-> Convertir : En polygones...

4. Renseigner les paramètres : 

Nombre couleurs : 
Réduction de points : augmenter la valeur pour ;  supprimer les
petits défauts ( pixels solitaires par exemple)

et Boucher les trous
qui pourrait apparaître à
la suite de cette
opération ;
Aperçu permettra de
visualiser le résultat sans
affecter l'image d'origine.

5. Glisser l'objet  dans la
galerie ou le «copier-
coller».dans le module
traitement de texte.

6. Truc  (?) : Sur l'objet vectoriel, une deuxième conversion en
polygones permettra de supprimer la couleur de remplissage et
d'obtenir le(s) contour(s)  qu'on pourra unifier avec la couleur de
ligne. ( ne me demander pas pourquoi il faut une deuxième
conversion !...)

7. Si on à besoin d'un outil plus puissant on découvrira avec intérêt,
Autotrace ou  Potrace ( intégré dans l'extraordinaire Inkscape :
http://www.inkscape.org/) .
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27 -   UTILISER LA «     GALERIE     »  

La galerie est un  outil particulièrement pratique pour stocker
des symboles ou des images qui seront  ainsi disponibles dans tous
les modules.

Ouvrir la galerie par  le pictogramme : 

A cet instant apparaît une fenêtre au dessus de la zone de
travail: 

On dispose ainsi de bibliothèque de symboles préexistants mais
on peut ajouter tout ce que l'on veux. Créer un nouveau thème en
cliquant sur le bouton et le nommer. Il suffira de glisser les objets de
l'espace de travail vers la zone de stockage. Pour  ce faire,
sélectionner l'objet, maintenir 2 secondes la pression sans bouger
(le contour semble clignoter une fois) puis sans relacher le bouton
de la souris, glisser l'objet vers la galerie.C'est tout ! On copiera un
symbole de la galerie vers l'espace de travail par simple
glissement.Le contenu de la galerie est disponible depuis tous les
module et est sauvegardé.
 Refermer la galerie par l'icône de la barre de fonctions.  
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28 -   PARAMÈTRES DE FONTWORK  

La commande FontWork n'est disponible que pour les objets
contenant du texte.

Vous pouvez modifier la forme de la base de texte afin de l'adapter à des demi-
cercles, des arcs, des cercles et des lignes à main levée.

Demi-cercle La ligne supérieure contient les
formes de base suivantes : Demi-
cercle supérieur, Demi-cercle
inférieur, Demi-cercle gauche et
Demi-cercle droit.

Arcs de cercle La ligne du milieu contient les
formes de base suivantes : Arc
supérieur, Arc inférieur, Arc
gauche et Arc droit

Cercle La ligne du bas contient les
formes de base suivantes : Cercle
ouvert, Cercle fermé, Cercle fermé
II et Cercle ouvert vertical. Pour
obtenir un résultat optimal, l'objet de
dessin doit contenir plus de deux
lignes de texte.

Désactivé Supprime le formatage de la base.

Rotation Utilise le bord supérieur ou inférieur de l'objet
sélectionné en tant que base du texte.

Debout Utilise le bord supérieur ou inférieur de l'objet
sélectionné en tant que base du texte et conserve
l'alignement vertical original de chaque caractère.

Basculer à
l'horizontal

Incline horizontalement les caractères dans l'objet de
texte.

Basculer à la
verticale

Incline verticalement les caractères dans l'objet de
texte.

Orientation Inverse la direction du texte et reflète le texte
horizontalement ou verticalement. Pour utiliser cette
commande, vous devez au préalable appliquer une base
différente au texte.

Aligné à gauche Aligne le texte sur l'extrémité gauche de la base de
texte.

Centré Centre le texte sur la base de texte.

Aligné à droite Aligne le texte sur l'extrémité droite de la base de texte.

Taille du texte
adaptée

Modifie la taille du texte de manière à ce qu'il
corresponde à la longueur de la base de texte

Distance Saisissez l'écart devant séparer la base de texte et la
base de chaque caractère.

Retrait Saisissez l'écart devant séparer le début de la base de
texte et le début du texte.

Contour Affiche ou masque la base de texte ou les bords de
l'objet sélectionné.

Contour de lettres Affiche ou masque les bordures de chaque caractère
dans le texte.

Pas d'ombre Supprime les effets d'ombre appliqués au texte.

Vertical Ajoute une ombre au texte présent dans l'objet
sélectionné. Cliquez sur ce bouton, puis saisissez les
dimensions de l'ombre dans les zones Distance X et
Distance Y.

Basculer Ajoute une ombre inclinée au texte présent dans l'objet
sélectionné. Cliquez sur ce bouton, puis saisissez les
dimensions de l'ombre dans les zones Distance X et
Distance Y.

Écart X Espacement horizontal

Saisissez l'écart horizontal devant séparer les caractères
du texte et le bord de l'ombre.

Écart Y Espacement vertical

Saisissez l'écart vertical devant séparer les caractères
du texte et le bord de l'ombre.

Couleur  d'ombre Couleur d'ombre

Sélectionnez une couleur pour l'ombre du texte.
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29 -   APPELER LES FONCTIONS DE DESSIN  

Un clic prolongé permet d'ouvrir la barre d'instruments flottante
Fonctions de dessin, à partir de laquelle vous pouvez ajouter des formes,
des lignes, du texte et des légendes au document actif.

Dessin Afficher les fonctions de dessin

Sélection Permet de sélectionner des objets dans le document actif.
Pour sélectionner un seul objet, cliquez dessus avec la flèche.
Pour en sélectionner plusieurs, faites glisser le curseur autour
des objets afin de dessiner un cadre de sélection. Pour ajouter
un objet à une sélection, appuyez sur Maj, puis cliquez sur
l'objet.

Ligne Dessine une ligne droite à l'endroit où vous faites glisser le
curseur dans le document actif. Maintenez la touche Maj
enfoncée pour imposer à la ligne un angle de 45 degrés lorsque
vous faites glisser le curseur.

Pour entrer du texte sur une ligne, double-cliquez sur cette
dernière, puis saisissez ou collez le texte. L'orientation du texte
correspond à la direction dans laquelle vous avez fait glisser le
curseur pour dessiner la ligne. Pour masquer la ligne,
sélectionnez Invisible dans la zone Style de ligne de la barre
d'objets.

Rectangle Dessine un rectangle à l'emplacement où vous faites glisser le
curseur dans le document actif. Pour dessiner un carré,
maintenez la touche Maj enfoncée pendant que vous faites
glisser le curseur. Cliquez sur l'endroit où vous voulez placer
un angle du rectangle et faites glisser le curseur jusqu'à
obtenir la taille voulue.

Vous pouvez modifier la taille d'un rectangle en faisant glisser
l'une des poignées de celui-ci.

Éllipse Dessine une ellipse à l'endroit où vous faites glisser le curseur
dans le document actif. Cliquez sur l'endroit où vous voulez
dessiner l'ellipse et faites glisser le curseur jusqu'à obtenir la
taille voulue. Pour dessiner un cercle, maintenez la touche Maj
enfoncée pendant que vous faites glisser le curseur. 

Polygone Dessine une ligne composée d'une série de segments de ligne
droits. Faites glisser le curseur pour dessiner un segment de
ligne, cliquez avec le bouton gauche de la souris pour définir le
point limite de celui-ci, puis faites glisser le curseur pour
dessiner un nouveau segment de ligne. Double-cliquez pour
finir le dessin de la ligne. Pour créer une forme fermée, double-
cliquez sur le point de départ de la ligne.

Lorsque vous maintenez la touche Maj enfoncée pendant le
traçage, les nouveaux points seront alignés sur des angles
incrémentés de 45° par rapport au point de départ.

Vous pouvez modifier séparément chaque point du polygone
lorsque vous activez le mode Éditer des points.

Courbe Dessine une courbe de Bézier lisse. Cliquez à l'endroit où vous
voulez faire commencer la courbe, faites glisser le curseur,
relâchez, puis amenez le pointeur à l'endroit où vous voulez que
la courbe s'arrête et cliquez avec le bouton gauche de la souris.
Déplacez le curseur et cliquez de nouveau pour ajouter un
segment de ligne droite à la courbe. Double-cliquez pour finir la
courbe. Pour créer une forme fermée, double-cliquez sur le
point de départ de la courbe. L'arc de la courbe est déterminé
par la distance sur laquelle vous faites glisser le curseur. 

Ligne à
main
levée

Dessine une ligne à main levée à l'endroit où vous faites glisser
le curseur dans le document actif. Pour terminer la ligne,
relâchez le bouton de la souris. Pour dessiner une forme
fermée, relâchez le bouton de la souris à proximité du point de
départ de la ligne.

Arc Dessine un arc dans le document actif. Pour dessiner un arc,
dessinez une ellipse en faisant glisser le curseur jusqu'à obtenir
la taille voulue, puis cliquez avec le bouton gauche de la souris
pour définir le point de départ de l'arc. Amenez le pointeur à
l'endroit où vous voulez placer le point limite, puis cliquez avec
le bouton gauche de la souris. Il n'est pas nécessaire de cliquer
sur l'ellipse. Pour dessiner un arc basé sur un cercle, maintenez
la touche Maj enfoncée pendant que vous faites glisser le
curseur.
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Secteur
d'éllipse

Dessine une forme pleine définie par l'arc d'une ellipse et par
deux lignes de rayon dans le document actif. Pour dessiner un
secteur d'ellipse, dessinez une ellipse en faisant glisser le
curseur jusqu'à obtenir la taille voulue, puis cliquez avec le
bouton gauche de la souris pour définir la première ligne de
rayon. Déplacez le curseur jusqu'à l'endroit où vous voulez
placer la seconde ligne de rayon, puis cliquez avec le bouton
gauche de la souris. Il n'est pas nécessaire de cliquer sur
l'ellipse. Pour dessiner un secteur de cercle, maintenez la
touche Maj enfoncée pendant que vous faites glisser le curseur.

Secteur
de cercle

Dessine une forme pleine définie par l'arc d'un cercle et par
une ligne de diamètre dans le document actif. Pour dessiner un
segment de cercle, dessinez un cercle en faisant glisser le
curseur jusqu'à obtenir la taille voulue, puis cliquez avec le
bouton gauche de la souris pour définir le point de départ de la
ligne de diamètre. Déplacez le curseur jusqu'à l'endroit où vous
voulez placer le point limite de la ligne de diamètre, puis
cliquez avec le bouton gauche de la souris. Il n'est pas
nécessaire de cliquer sur le cercle. Pour dessiner un segment
d'ellipse, maintenez la touche Maj enfoncée pendant que vous
faites glisser le curseur.

Texte Dessine, à l'endroit où vous faites glisser le curseur dans le
document actif, une zone de texte ayant une orientation de
texte horizontale. Dessinez une zone de texte à l'endroit de
votre choix dans le document en faisant glisser le curseur
jusqu'à obtenir la taille voulue, puis saisissez ou collez le texte.

Animatio
n de texte

Dessine, à l'endroit où vous faites glisser le curseur dans le
document actif, une zone de texte ayant une orientation de
texte horizontale. Dessinez une zone de texte à l'endroit de
votre choix dans le document en faisant glisser le curseur
jusqu'à obtenir la taille voulue, puis saisissez ou collez le texte.

Légendes Dessine une ligne se terminant par une légende rectangulaire à
orientation de texte horizontale à partir de l'endroit où vous
faites glisser le curseur dans le document actif. Faites glisser
une poignée de la légende pour en modifier la taille. Pour
ajouter du texte, cliquez sur le bord de la légende puis saisissez
ou collez votre texte. Pour transformer la légende rectangulaire
en légende arrondie, faites glisser la plus grande des poignées
d'angle lorsque le pointeur prend la forme d'une main.

Ces commandes ne sont accessibles que si vous activez la prise en charge
des langues asiatiques dans Outils - Options - Paramètres linguistiques -

Langues.

Légende
verticale

Dessine une ligne se terminant par une légende rectangulaire à
orientation de texte verticale à partir de l'endroit où vous faites
glisser le curseur dans le document actif. Faites glisser une
poignée de la légende pour en modifier la taille. Pour ajouter
du texte, cliquez sur le bord de la légende puis saisissez ou
collez votre texte. Pour transformer la légende rectangulaire en
légende arrondie, faites glisser la plus grande des poignées
d'angle lorsque le pointeur prend la forme d'une main.

Texte
vertical 

Dessine une zone de texte dont la direction de texte est
verticale, à l'endroit où vous cliquez ou faites glisser le curseur
dans le document actif. Cliquez n'importe où dans le document,
puis saisissez ou collez le texte. Vous pouvez également amener
le curseur jusqu'à l'endroit où vous souhaitez ajouter du texte
afin d'y dessiner une zone de texte, puis saisir ou coller le texte
en question.
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30 -   ACTIVER LA BARRE D'OBJETS «     BÉZIER     »  
( ÉDITION DE POINTS)

La barre d'objets Bézier s'affiche lorsque vous sélectionnez
une courbe de Bézier et cliquez sur Éditer des points.

Les fonctions fournies vous permettent d'éditer les points d'une
courbe ou d'un objet converti en courbe. Les icônes disponibles sont
les suivantes :

Éditer des
points

A l'aide de l'icône Éditer des points, vous
pouvez activer ou désactiver le mode
Édition des objets Bézier. Si le mode Édition
est activé, vous pouvez sélectionner chaque
point de l'objet de dessin.

Déplacer des
points

Active un mode dans lequel vous pouvez
déplacer les points. Le pointeur de la souris
affiche un petit carré vide lorsque vous le
maintenez sur un point. Faites glisser ce
point vers un autre emplacement. La courbe
située des deux côtés du point suit le
mouvement, sa partie comprise entre les
points adjacents changeant de forme.

Scinder la
courbe

L'icône Scinder la courbe coupe une
courbe en deux. Sélectionnez le ou les
points où vous voulez scinder la courbe, puis
cliquez sur l'icône.

Supprimer des
points

Permet de supprimer un ou plusieurs points
sélectionnés. Pour sélectionner plusieurs
points, cliquez dessus en maintenant la
touche Maj enfoncée. 

Sélectionnez d'abord les points, puis cliquez
sur cette icône. Vous pouvez aussi appuyer
sur la touche Suppr pour supprimer les
points.

Insérer des
points

Active le mode Insertion. Ce mode vous
permet d'insérer des points. Vous pouvez
également déplacer des points exactement
comme dans le mode Déplacer des points. Si
néanmoins vous cliquez sur la courbe entre
deux points et déplacez légèrement la souris
tout en maintenant enfoncé son bouton
gauche, vous insérez un nouveau point. Ce
dernier est lisse et les lignes qui le relient à
ses points de contrôle sont parallèles et le
restent lorsque vous le déplacez.

Pour créer un point d'inflexion, vous devez
en premier lieu insérer un point lisse ou
symétrique, lequel est ensuite converti en
point d'inflexion avec l'option Point
d'inflexion
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Convertir en
courbe

Convertit une ligne droite en courbe ou vice
versa. Si vous sélectionnez un point unique,
la partie de courbe précédant le point est
convertie. Si vous sélectionnez deux points,
la partie entre les deux points est convertie.
Si vous sélectionnez plus de deux points,
une partie différente de la courbe est
convertie chaque fois que vous cliquez sur
cette icône. Si nécessaire, les points
arrondis sont convertis en angles et les
angles en arrondis.

Si une partie de la courbe est droite, les
points des extrémités de la droite n'ont
qu'un point de contrôle chacun. Ce n'est
alors plus possible d'en faire des points
arrondis, à moins de reconvertir la droite en
courbe.

Point
d'inflexion

Permet de transformer le point actif ou les
points sélectionnés en points d'inflexion. Les
points d'inflexion comportent deux points de
contrôle indépendants déplaçables
séparément ; le tracé de la courbe passe sur
un point d'inflexion en dessinant un angle.

Jonction lisse Permet de transformer un point d'inflexion
ou un point symétrique en un point lisse.
Les deux lignes vers les points de contrôle
des points d'inflexion sont parallèles et ne
peuvent être déplacées qu'ensemble. Les
lignes vers les points de contrôle peuvent
toutefois être de longueur différente, ce qui
entraîne une courbure plus ou moins
importante de la courbe.

Jonction
symétrique

Cette icône convertit un point d'inflexion ou
un point lisse en un point symétrique. Les
points de contrôle du point d'inflexion sont
alignés parallèlement et sont de même
longueur. Ils ne peuvent pas être déplacés
séparément et leur courbure est définie
selon le même degré dans toutes les
directions.

Fermer Bézier Ferme une ligne ou une courbe. Une ligne
est fermée lorsque son dernier point est
connecté à son premier point, ce qui est
signalé par un carré agrandi.

Réduire les
points

Marque le point actif ou les points
sélectionnés pour les supprimer. Cela se
produit lorsque le point est situé sur une
ligne droite. Si vous convertissez une
courbe ou un polygone en ligne droite à
l'aide de l'icône Convertir en courbe ou
que vous modifiez une courbe avec la souris
de sorte qu'un point se retrouve sur une
ligne droite, ce dernier est supprimé.
L'angle à partir duquel la réduction du point
est effectué est de 15° par défaut.
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